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Welcome to 2016 Knowledge-Based Audits, Preparations, Compilations and Reviews™ of Common Interest Realty
Associations for ProSystem fx® Knowledge Coach

This Release Notes document provides important information about the 2016 release of Knowledge Based Audits, Preparations,
Compilations and Reviews ™ of Common Interest Realty Associations. Please review this information carefully. If you have any
questions, contact Customer Support at 1-800-PFX-9998, option 4, then option 1. Additional information is available on CCH Support
Online.

New in this Release

Knowledge-Based Audits, Preparations, Compilations and Reviews of Common Interest Realty Associations (CIRAs) is designed to help
the practitioner efficiently and effectively perform financial statement audits of CIRAs in accordance with auditing standards generally
accepted in the United States (U.S. GAAS), and preparations, compilations, and reviews of CIRAs in accordance with Statements on
Standards for Accounting and Review Services (SSARSs) issued by the Accounting and Review Services Committee of the American
Institute of Certified Public Accountants.

The Knowledge-Based Audit is a risk-based methodology that emphasizes using knowledge of the CIRA to make risk assessments in
connection with a financial statement audit. This allows the auditor to more appropriately focus audit efforts on those areas which in
the auditor’s judgment are the most significant and pose the most risk to the financial statement audit. The operations of CIRAs are
often unique and complex and require specialized accounting and auditing knowledge. This edition includes specific up-to-date
guidance for auditing CIRAs. Conducting audits of CIRAs requires the exercise of the auditor’s professional judgment.

The Knowledge-Based Preparations, Compilations and Reviews Methodology emphasizes using knowledge of the CIRA to perform
preparation, compilation, and review engagements by facilitating the flow of information so that the understanding obtained in each
process affects the decisions made in the next. Although the accountant will likely perform most steps in this methodology
sequentially, conducting an engagement is not necessarily a linear process. Knowledge gained from preliminary engagement activities
helps the accountant design and customize engagement procedures; evidence gained from procedures performed is evaluated and the
appropriate accountant’s report, if any, is issued. This edition includes specific up-to-date guidance for conducting preparation,
compilation, and review engagements of CIRAs in accordance with the SSARSs.

The operations of CIRAs are often unique and complex and require specialized accounting and auditing knowledge. This edition includes
specific up-to-date guidance for performing attestation engagements of CIRAs.

Conducting audits and attestation engagements of CIRAs requires the exercise of the auditor’s professional judgment. This document is
published for the purpose of communicating, to users of the toolset, updates and enhancements included in the current version. This
document is not, and should not be used as an audit program to update the audit documentation of an engagement started in a
previous version of this product.

This is the fifth update to this Knowledge Coach title. If you are updating from a previous version of this title, refer to the Knowledge
Coach User Guide Chapter 12. The guide is found on the Engagement File Room Help menu.

The 2016 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis
related to the steps and processes discussed in the workpapers.

The 2016 edition of Knowledge-Based Audits of CIRAs features numerous enhancements, including:
¢ Updated text and column header in KBA-103 to clarify the decision making process
¢ Added a “Not Applicable” option in the “Functioning” column in the summary tables in KBA-401 and KBA-401N


http://support.cch.com/productsupport/
http://support.cch.com/productsupport/

Added a “Potential Error Diagnostic” in KBA-400 to note if an audit area has a significant or fraud risk but no risk has been
identified this will notify the user to a potential error.

Removed "Potential Error Diagnostic" on last column (Control Understanding / Testing Workpaper) of Table 1in KBA-400 when
the user selects to add a, "Custom Value" option. The user would only select a “Custom Value” option if they're using a memo
or non-KC workpaper to document their understanding of activity level controls. This diagnostic will continue to show if the
user selects any other options and has not included the recommended workpaper option.

Moved the section on Future Major Repairs and Replacements including the Reserve Study for Remaining Useful Lives of
Common Property and Costs from AUD-806 to AUD-811. These steps will be retained on Rollforward if the user selects to
“Keep” the responses in this workpaper on Rollforward.

One new report is available in this title:

RPT-0935a Unmodified Opinion on Comparative Financial Statements with Emphasis-of-Matter Paragraph: Opinion
on the Financial Statements of a Prior Period is Revised to Reflect Adoption of a Private Company Council Accounting
Alternative for VIE's that Results in a Change to a Previously Issued Report.

Audit Overview:
http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2016%20CIRA%20Audit%20Title%200verview%20for%20Knowle

dge%20Coach%20Users.pdf

Preparation, Compilation, and Review Overview:
http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2016%20CIRA%20Prep%20Comp%20Rev%20Title%200verview%

20for%20Knowledge%20Coach%20Users.pdf

In addition, forms and practice aids throughout have been updated to include new examples and tips and, where applicable, to take into
account:

New literature, standards, and developments, reflected in the following current audit and accounting guidance:

Audit Title

¢
¢

SAS No. 129, Letters for Underwriters and Certain Other Requesting Parties;

FASB Accounting Standards Codification as of December 31, 2015, and through Accounting Standards Update No. 2015-17,
Income Taxes (Topic 740): Balance Sheet Classification of Deferred Taxes

Preparation, Compilation and Review Titles

¢

¢
¢
¢
¢
¢
¢

Statement on Standards for Accounting and Review Services No. 21 (SSARS No. 21), Clarification and Recodification;
AICPA Statement on Quality Control Standards No. 8, A Firm's System of Quality Control (Redrafted) (QC Section 10);
AR-C Section 70, Preparation of Financial Statements;

AR-C Section 80, Compilation Engagements;

AR-C Section 90, Review of Financial Statements;

Nonattest Services interpretation (ET Section 1.295); and

AICPA Code of Professional Conduct (Code).

Additional Information on Knowledge Coach and the KBA Methodology

Knowledge-Based Audit (KBA) Methodology - Allows the results of one set of procedures to become the input for the next. The key
components of the KBA methodology include:

¢

An Overview that guides auditors through the methodology;


http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2016%20CIRA%20Audit%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2016%20CIRA%20Audit%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2016%20CIRA%20Prep%20Comp%20Rev%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2016%20CIRA%20Prep%20Comp%20Rev%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf

Knowledge-Based Audit documents, integral to the risk assessment and overall audit processes, which contain steps and
procedures required by GAAS;

Customizable Audit Programs that take auditors through related steps and procedures;

Practice Aids to help auditors complete steps or processes outlined in the Knowledge-Based Audit documents and Audit
Programs;

Auditor’s Reports that provide a variety of sample auditor’s opinions on audited financial statements; and

Correspondence documents that provide sample letters to be used to comply with GAAS requirements and in many other
common situations.

The AICPA’s Auditing Standards Board’s (ASB) Risk Assessment Standards - The practice aids and tools in the 2016 Knowledge-
Based Audits, Preparations, Compilations and Reviews of CIRAs are designed around the AICPA's risk assessment and clarified
standards to assist auditors of CIRAs by:

e  Facilitating compliance with GAAS and GAGAS;
e Encouraging more effective audits through tailored audit programs and comprehensive practice aids;
e Helping auditors to focus on and respond to identified audit risks; and

e Enhancing audit documentation.

Knowledge-Based Preparation, Compilation and Review (KBPCR) Methodology - Allows the results of one set of procedures to become
the input for the next. The key components of the KBPCR methodology include:

¢
¢

An Overview that guides practitioners through the methodology;

CIRA Preparation Programs, Compilation Programs and Review Programs that take accountants through related steps and
procedures designed for use in compilation and review engagements;

Practice Aids to help accountants complete steps or processes outlined in other related documents and provide example
financial statement formats for different types of entities;

Reports that provide a variety of sample accountant’s reports on compiled or reviewed financial statements;

Correspondence documents that provide sample engagement letters and management representation letters to be used in
many common situations; and

Knowledge-Based Preparation, Compilation and Review documents, integral to the overall engagement process, that contain
steps and procedures required by SSARSs.

The AICPA’s Accounting and Review Services Committee (ARSC) SSARS - The practice aids and tools in the 2016 Edition of Knowledge-
Based Preparations, Compilations and Reviews of CIRAs are designed around the AICPA’s SSARS standards to assist accountants by:

¢
¢
¢

Facilitating compliance with the SSARS;
Encouraging more effective engagements through tailored engagement programs and comprehensive practice aids; and

Enhancing engagement documentation.

ProSystem fx® Knowledge Coach

¢

ProSystem fx® Knowledge Coach functionality allows auditors/accountants to use the Knowledge-Based-Audit methodology
more efficiently by eliminating the need for duplicate entry of the same information, tailoring audit documentation to each
particular engagement, and documenting the link between risks identified and procedures performed. AUD-100 Tailoring
Question, PRP-100 Tailoring Question Workpaper, CMP-100 Tailoring Question Workpaper or REV-100 Tailoring Question
Workpaper is a document in Knowledge Coach that presents engagement-level questions designed to aid in tailoring the
engagement documentation to fit each client. Completing the questions helps the auditor avoid duplication and unnecessary
workpapers.

Before you begin your audit, preparation, compilation or review, please review the guidance in AUD-101 Overall Audit Program,
PRP-101 Overall Preparation Program, CMP-101 Overall Compilation Program or REV-101 Overall Review Program. This
workpaper is intended to be your road map through a Knowledge-Based Audit methodology. You should start your audit with
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AUD-100 Tailoring Question Workpaper, PRP-101 Overall Preparation Program, CMP-100 Tailoring Question Workpaper or
REV-100 Tailoring Question Workpaper and AUD-101 Overall Audit Program, CMP-101 Overall Compilation Program or REV-
101 Overall Review. and AUD-101 Overall Audit Program.

In the Audit title only, risks can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the
current editor of KBA-502 Summary of Risk Assessments. This allows the user to continuously assess risks during the
engagement. Several workpapers prompt the consideration of the presence of risks, but the Risk Summary task pane must be
used to document those risks. All documented risks flow to the Risk Summary. To ensure risks show in findings tables, make sure
to check the “workpaper identified in” field of the Risk pane.

The Risk Assessment features have been disabled for the 2016 Knowledge-Based Preparations, Compilations and Review Title for
Knowledge Coach. Refer to KBP-101 Preparation: Significant Matters, KBC-101 Compilation: Significant Matters and KBR-102
Review: Significant Matters to accumulate and review significant issues and findings. PRP-801 Preparation Program, CMP-801
Compilation Program: Significant Risks and Uncertainties and REV-802 Review Program: Significant Risks and Uncertainties
provides a guide for implementing the guidance related to the disclosure of certain significant risks and uncertainties.

Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent
information ensures that information and updates to information are not missed between workpapers. Drill-down functionality
helps the user navigate quickly to the source of the information, aiding in the review of the audit file.

Diagnostics help keep track of unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks
or relevant assertions, missing workpaper, and more.

Links to Accounting Research Manager (ARM)-If you subscribe to an ARM library that includes audit content, you can link
directly to source material from Resources within Knowledge Coach workpapers. These links have been updated to reference to
the accounting standards under the FASB Accounting Standards Codifications and the auditing standards issued by the AICPA.
Also, if you subscribe to the Knowledge-Based Audits, Preparations, Compilations and Reviews of CIRAs Guide on ARM, you can
take advantage of links to the audit guide material from within the Knowledge Coach documents.

Interpretive Guidance is integrated into each Knowledge Coach template through the Tips view of each new task pane.
Informational features include Practice Points, Examples, Optional Workpapers, and Resources to help auditors work more
effectively and efficiently. You can also navigate from Resources within a document or the tip pane directly to CCH'’s Accounting
Research Manager and industry audit guides by simply clicking on the Reference.

Important Notes

¢
¢

Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.

If your Current Editor Knowledge Coach MS® Word workpapers become read-only or crash, please do the following:
o Keep the binder with the affected workpapers open.
o Highlight the workpaper in the binder window and go to Tools > Save Knowledge Coach Answers.
Knowledge Coach cannot be used within the Shared File Room (SFR) feature of Engagement. However, Knowledge Coach

workpapers can be shared across team members through check in, check out, workpaper assignment, syncing to the central file
room and through peer-to-peer sync in the same way other Engagement workpapers are shared.

System Requirements

¢

This title MUST be used with ProSystem fx ® Engagement version 7.2, ProSystem fx® Knowledge Coach version 2.2, and 2015
Financial Statement Base v4 and higher. If you have not installed the ProSystem fx® Engagement 7.2 and Knowledge 2.2
Update September 2015, ensure that you do so before using this title. If you are upgrading from ProSystem fx® Engagement 7.1
or lower please contact Technical Support at 1-800-PFX-9998, option 4 for detailed instructions.

A minimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx®
Knowledge Coach workpapers.

Download Instructions

Download the 2016 Knowledge Based Audits, Preparations, Compilations and Reviews of CIRAs from the ProSystem fx ®Knowledge
Coach Updates section of the ProSystem fx® Engagement Support Web site at the following URL:
http://support.cch.com/updates/KnowledgeCoach, then select the Knowledge Coach Series (Audit, Preparation, Compilation or Review)



http://support.cch.com/updates/KnowledgeCoach

and Download file link next to the 2016 Knowledge-Based Audits, Preparations, Compilations and Reviews of CIRAs. On some occasions
the content package file ((KCP) will download with the extension changed to .ZIP. If this occurs, please change the extension of the
downloaded file to KCP using all capital letters.

You must install the 2015 Financial Statement Base v4 title before installing the 2016 Knowledge Based Audits, Preparations,
Compilations and Reviews of CIRAs.

The Financial Statement Base title is also available at the following link: http://support.cch.com/updates/KnowledgeCoach

If you have already installed this title for 2016 Knowledge-Based Audits, Preparations, Compilations and Reviews of CIRAs, ensure you
have the latest Knowledge Coach Content Update installed.

Important: ProSystem fx® Engagement version 7.2 or higher and Knowledge Coach version 2.2 must be installed on the computer in
order to install this Knowledge Coach title. Additional requirements include Microsoft® Office 2007, Microsoft® Office 2007 Primary
Interop Assemblies (PIA) and Visual Studio® 2005 Tools for the Office Second Edition Runtime, Visual Studio® Tools for Office System
Runtime version 3.0, and Visual Studio® Tools for the Office System 3.0 Runtime Service Pack 1., Visual Studio® Tools for Office
Runtime 4.0 (VSTOR) (32-bit version for 32-bit OS and 64-bit version for 64-bit OS).

The 2016 Knowledge-Based Audits, Preparations, Compilations and Reviews of CIRAs (3/10/16). KCP download is a proprietary file that
must be installed from within Engagement. Save this KCP file to a location on your local drive and follow the Installation Instructions
included in the Release Bulletin.

Installation Instructions

Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx ® Engagement.
The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach Program content files.
Please refer to the ProSystem fx ® Engagement with Knowledge Coach Release Notes for any other system requirements.

After downloading the 2016 Knowledge Based Audits, Preparations, Compilations and Reviews of CIRAs, do the following:

¢ Launch the ProSystem fx ® Engagement Workpaper Management application so that the Local File Room is displayed. Select
Tools > Knowledge Coach Titles.

¢ The Knowledge Coach Titles window will be displayed.
¢ Choose Add Title.

¢ Browse to the title package file (*.KCP) that you previously downloaded from the ProSystem fx ® Knowledge Coach Support
Web site.

¢ Choose Open.

¢ The system will display a progress indicator while the title package is added. You will receive a message that the title has been
successfully installed once the process is complete.

Once the title is added, you must release it, so that other staff members in your firm can use it. You may also wish to “unrelease”
previous versions of the title.

To unrelease a title:
¢ Select a version of the KBA CIRAs titles.

¢ Choose Unrelease Title. The date will be removed from the Date released column and staff that do not have the staff group
property right to insert unreleased titles will not be able to insert the unreleased titles into a binder.

Note: You can determine this access in the ProSystem fx® Engagement Admin module by selecting a staff group and choosing File >
Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option.

To release a title:
¢ Select one of the Knowledge Coach titles in the list that has been added but is not yet released.

¢ Choose Release Title. The current date and time will be displayed in the Date released column, and the status will change to
“Released.”


http://support.cch.com/updates/KnowledgeCoach

Note: You must add and assign a Knowledge Coach module as well as the Knowledge Coach title license in the ProSystem fx ®
Engagement Administrator before using the workpapers.

Important: Once the 2016 Knowledge-Based Audits, Preparations, Compilations and Reviews of CIRAs titles have been added and
released, they will be automatically deployed to other staff members when they login to the “Office” location, or when they
synchronize a binder that contains Knowledge Coach workpapers from this title.

Online Permission Key

Permission key files may be downloaded from our Web site at https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx
or when adding or updating the new licenses within ProSystem fx® Engagement with Knowledge Coach version 7.2 and higher. After
updating the license file in the ProSystem fx® Engagement Admin module, licenses need to be assigned to the staff who will use 2016
Knowledge-Based Audits, Preparations, Compilations and Reviews of CIRAs.

If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.

Permission keys are no longer generally distributed via floppy diskette. You can choose to continue receiving the diskette by going to
https://prosystemfxsupport.tax.cchgroup.com/service/accountadmin/ , clicking the Firm Administration link, and making the
appropriate selection (SSO access is required), or by contacting Customer Service at 1-800-PFX-9998, option 4.

Accounting Research Manager

CCH'’s Accounting Research Manager is the most comprehensive, up-to-date and objective online database of financial reporting
literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written
interpretive guidance.

Our Weekly Summary email newsletter highlights the key developments of the week, giving you assurance that you have the most
current information. It provides links to new FASB, AICPA, SEC, EITF, and IASB authoritative and proposal-stage literature, plus guidance
from financial reporting experts.

Our team of content experts updates the system on a daily basis, so you can stay as current as possible. What's more, our experts
attend critical, standard-setting meetings and summarize the results for you, which means you’ll learn of newly released literature and
deliberations of current financial reporting projects as soon as they occur! Plus, you'll benefit from their easy-to-understand technical
translations. Our expert’s interpretations clearly lay out what the rules mean from your perspective.

Also available in the Knowledge-Based Audits, Preparations, Compilations and Reviews of CIRAs title, a guide that helps you comply
with the most recent professional standards and guidance for the conduct of compilations and reviews and to integrate the use of
practice aids, tools, and other resources with its guidance. This publication supplements and complements the Knowledge-Based
documents that are available in Knowledge Coach.

With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about
our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com. You can also
access the Accounting Research Manager Web site by selecting the item in ProSystem fx ® Engagement from the Guidance tab on the
Shortcuts bar in the Binder window.

Reference to Accounting Research Manager (ARM) - If you subscribe to an ARM library that includes CIRAs content, you can link directly
to source material from Resources within Knowledge Coach documents. These links have been updated to refer to the accounting
standards under the FASB Accounting Standards Codifications. Also, if you subscribe to the Knowledge-Based Audits, Preparations,
Compilations and Reviews of CIRAs Guide on ARM, you can take advantage of references to the guide material from within the
Knowledge Coach documents.

Using Your Knowledge Coach Content
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To use your Knowledge Coach Workpaper
Templates, open a binder in ProSystem fx®
Engagement, select the workpaper tab into which
you would like to insert the workpaper, and select
New Knowledge Coach Workpaper from the toolbar
or File menu. The New Knowledge Coach Workpaper
dialog appears (Figure 1).

Select the New Knowledge Coach Title with the
content you would like to use. You can only select
titles you have installed. The information displayed
changes to reflect the workpaper organization
available for the selected title. Select the Knowledge
Coach Workpaper Templates to insert into your
binder and click OK. The Selected Workpaper
Properties dialog appears. Each workpaper name is
automatically loaded into the Name field. Add a
workpaper index in the Index field and make any
Name modifications you desire. You can also modify
the tab location or the roll forward settings for each
workpaper. Then click OK. The integrated Knowledge
Coach workpaper is now inserted into your
engagement binder. For more information on how to
use Knowledge Coach workpapers in your binder, see
the Knowledge Coach User Guide.

New Knowledge Coach Workpaper

Industry: 2016 KBA CIRA v | |-E

[] Add Independent \Workpapers without Foundation 'workpapers

#-[ |  DO0-Resources

- 100-The Communications Hub
200-Pre-Engagement Procedures

200-Review Procedures

500-Evaluating. Concluding & Reporting Procedures

Details of selected workpaper

3-
3-
3.

OO00

Highlight a workpaper or select
a workpaper check box to see
details.

Figure 1- New Knowledge Coach Workpaper
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Platforms: Windows® 7, 8 and 8.1

Office: Microsoft® Office 2007 required

Contact Information

¢ For ademo or to purchase additional titles as they become available 1-800-PFX-9998, option 1

¢ Technical Support 1-800-PFX-9998, option 4, then option 1

The ProSystem fx® Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by CCH, a
Wolters Kluwer business. The contact information above can be used for customer service and support issues for this product. For
information about other CCH products, please call 1-800-248-3248 or visit the online Store at http://tax.cchgroup.com.



